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TECHNICAL INFORMATION 

SYSTEM REQUIREMENTS, SOFTWARE, PLATFORM 

Desktop browser:  
 Internet Explorer 6.0 or higher 
 
Desktop synchronization:  
 HTTP access to a web server 
 .NET Compact Framework 
 SQL Server CE 
 Microsoft ActiveSync 3.7 or higher 
 Pocket Audit application  
 
Handheld PDA:  
 Microsoft RepliSync, to be provided by Hardtek  
 Pocket PC with Microsoft OS 
 
Camera, if not integrated into the PDA, must be able to save images in .jpg or .gif file format 
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SUPPORT 

A User Implementation Program is available. Contact HARDTEK for information.  
 
Online support is available by email. Contact info@hardtekauditingsolutions.com and a representative will respond.  
 
Other contact information: 
 Healthcare Support Services 
 Vicksburg, MI  49097 
 Phone: 269-649-1623, Fax: 269-349-4076 
 

PRINTING THIS USER’S MANUAL 

Select Landscape orientation. 
 

mailto:info@hardtekauditingsolutions.com
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LICENSING AGREEMENT 

The Facility Management Software program is licensed for use by a single organization and may not be used for processing of third 
party data. User agrees:  
 

(a) Not to remove any Healthcare Support Services notices in the software.  
(b) Not to sell, transfer, rent, lease, or sub-license the software or documentation to any third party. 
(c) Not to alter or modify the software.  
(d) Not to reverse engineer, disassemble, decompile, or attempt to derive source code from the software or prepare derivative 

works from it. 
 
Healthcare Support Services and its suppliers own the software, including, without limitation, any and all worldwide copyrights, 
patents, trade secrets, trademarks, and proprietary and confidential information rights on or associated with the software. The software 
is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. No 
ownership rights in the software are transferred to the user.  
 
Licensor reserves all rights with respect to the Licensed Products and Hardware under all applicable laws for the protection of 
proprietary information, including trade secrets, copyrights, trademarks, and patents.  
 
Licensee shall not cause or permit unauthorized copying, reproduction, or disclosure of any portion of the Licensed Products, or any 
instructions, manuals, or other documentation, or the delivery or distribution of any part thereof to any third person or entity, for any 
purpose whatsoever, without the prior written permission of Licensor. This restriction shall continue to bind Licensee and its agents 
and representatives beyond the termination of this agreement.  
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OVERVIEW  

 
The Hardtek Auditing Solutions Facility Management Software Program system is designed to 
automate facility inspection results, allowing for faster reporting and correction of issues, thus 
helping facilities be proactive in monitoring, reporting, and correcting issues and promoting safety 
and regulatory compliance within any healthcare setting or production plant facility. The Facility 
Management Software is used with a laptop or desktop computer with an Internet browser and 
handheld personal digital assistant (PDA).  
 

System setup consists of populating fields under the Facility Management, Audit Management, and User Management tabs, and is 
accomplished by selecting from drop-down menus or creating custom lists.  This task can be done by a facility administrator, with the 
optional assistance of a Healthcare Support Services representative.  
 
Facility Management setup consists of choosing the facility locations to be audited, and can be as detailed as desired, to include the 
following: system, facility, building, floor, department, area, and work station.  
 
Audit Management setup consists of programming the audits by selecting from a drop-down menu or by creating a custom list. Audit 
elements are then linked to the standards that support them. 
 
User Management setup consists of adding or editing users and assigning one of four levels of permission. 
 
Once setup is complete, an auditor can perform inspections, using a handheld PDA to record any deficiencies found; deficiencies are 
linked to a department or facility area and the standards or elements of compliance.  The PDA’s digital camera feature allows the 
auditor to photograph deficiencies onsite.  
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Following the audit, the auditor emails the audit findings with photo attachments to the unit managers, directors, and other parties 
responsible for resolving the issues found. The email serves as a work order for correcting issues. 
 
The Facility Management Software’s powerful Reports function lets any user generate ten static reports and any number of ad hoc 
reports to trend deficiencies within the facility. 
 

PREVIEWING THE SOFTWARE ON THE WEB 

To access the website, go to: http://www.hardtekauditingsolutions.com/Login.aspx. 
From the first screen, the user may view a Demo of the Facility Management Software Program without logging in.  

http://www.hardtekauditingsolutions.com/Login.aspx
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THE LOGIN SCREEN MENU 

Navigate to the help page or the contact page by 
selecting the appropriate choice from the menu at the top 
of the Login screen; other options include viewing the 
Demo or logging in. 
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Demo 
The Demo provides an automated tour of the software and the key 
tasks that can be performed under each menu tab. 
 
During the Demo, use the controls in the panel at the bottom of the 
screen to rewind, go back, play, pause, go forward, exit, or access information.  You do not need to log in to play the Demo. 

 

1.  

 
Login 
Enter your User name. 
Enter your Password.  

Note: Username and password are restricted to 20 characters each 
and are case sensitive. If you have forgotten your password or 
are having problems logging in, please contact your system 
administrator. 

Click on Login. 
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WELCOME SCREEN 

Successful login takes you to the Welcome screen, 
which is used to communicate information regarding 
upgrades to the program and other important 
information. This screen also features the License 
Agreement. 
 
From this screen the user can access up to five 
function tabs, which appear across the green web 
banner (shown circled in red). The available tabs 
depend upon the user’s permission level. The five 
function tabs are:  
facility management 

audit management 

user management  

admin tools 

reports 
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PERMISSION LEVELS 

Program functionality and access are determined by a user’s permission level.  A user can view anything at or below his or her 
permission level. The four permission levels are shown below.  
 
Note:  All users may access any of the reports available under the reports tab. 
 
Level I User  
Permissions related to audit types 
User management tasks: edit users 
 
Level II Facility Administrator  
Permissions related to a single facility 
Audit management tasks 
User management tasks: add users 
 
Level III Hospital System Administrator 
Permissions related to an entire health system 
Facility management tasks 
 
Level IV Consultant 
Permissions related to a number of health systems 
All program functions 
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User Titles, Permission Levels, and Associated Tasks 

 
 

Associated Tasks 
User Title Permission 

Level Add Users Edit Users Audit  
Management 

Facility 
Management Reports 

User  I  x   x 

Facility Administrator  II x x x  x 

Hospital System Administrator  III x x x x x 

Consultant  IV x x x x x 
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THE FIVE FUNCTION TABS 

The drop-down choices and tasks related to each function tab are given below. 
 
Facility Management  

• Add/Edit Facility—change department names, key contacts, etc. 

• Add/Edit Directors—update director contact information 

• Add/Edit Supervisors—update supervisor contact information 
 

Audit Management 

• Manage Audit—edit or email audits performed within a specified date range 

• Audit Type—edit an existing audit type or add an audit type 
 

User Management 

• Create User—add a new user 

• Edit User—revise or update information about a current user 
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Admin Tools 

• The administrative tools tab is functional only for users with Level IV permission and may not appear on your menu bar. 

 

Reports 

• Ad Hoc Reports – to generate a unique report using specific variables  

• Static Reports (listed by type) – to generate 10 common reports: 
Audit History 
Audit Detail/Summary 
Summary 
Director 
Supervisor 
Department 
Standard 
Deficiency 
Auditor 
Tally Points 
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AUDIT SETUP AND REPORTING 

FACILITY MANAGEMENT TASKS 

Add/Edit Facility 
Select Add/Edit Facility from the facility 
management tab drop-down menu. A series of 
screens will open that require information.  
 
When all fields are populated, click on Save or 
Update to save changes. Click on Delete to delete. 
The screen will refresh and new fields will display. 
 
When the initial Edit Facility screen appears: 
 
Select a hospital system from the Select Hospital 
System field drop-down menu or enter the name of a system. 
  
Select a facility from the Select Facility field drop-down menu, or enter the name of a facility  
 
Note: Status will default to Active unless Inactive is selected. Selecting Inactive will retain the information in the database so it can 

be later activated. Inactive status will display on the computer, but not on the PDA.  
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The screen refreshes. The name of the facility 
appears in the Facility Name field. In the 
example, the system and facility are “Bronson 
Methodist Hospital”. 
 
Notice that new fields now display.  
 
Click on the Emails button (circled in red) to enter 
email recipients in addition to the customary unit 
manager, director, and/or supervisor, for those 
instances when another responsible party needs 
to be copied on an email. 
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The screen refreshes and the Edit Email screen 
opens. Previously entered information will appear 
in the Email Description and Email Address fields. 
 
Click on Add to enter a new contact. 
 
 
 
 
 
 
The screen refreshes and two yellow fields 
appear. 
 
In the Email Description field (left), enter the 
names of any additional departments of 
responsibility (in the example, “Safety”) you want 
to receive emails. Enter the email address in the  
Email Address field (right). 
 
Click on Save.



 

 

 

19 

When you are returned to the Edit Facility screen: 
 
Select a building from the Select Building drop-
down menu or type in the name of a new building 
into the Building Name field. (in the example, “Main 
Building”). 
 
Click on Save to add the building to the facility. 
 
The screen will again refresh. A new field opens, 
Facility Areas. 
 
Click on Add New Facility Area in the text box. 
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The screen refreshes. A new field opens, Facility 
Area. 
 
Enter the name of the area into the field. In the 
example, “1 East” is designated. 
 
Click Update to add the area to the facility. 
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The screen refreshes. The name of the facility area you 
entered will appear in the Facility Areas field. A new field, 
Departments, displays next to it. 
 
Select a department from the drop-down menu or click on 
Add New Department. 
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The screen refreshes and a set of Department 
fields displays. Scroll down, as necessary, to 
view them.  
 
Select a department from the drop-down list or 
click on Custom Department to add the name 
of a department. In the example, “General 
Medical Unit” has been designated. 
 
Enter the appropriate information into the 
Contact Name and Contact Email fields. 
 
Click on Select a Director and select a name 
to link a director to the department. Click on 
Update. 
 
Note: A new director cannot be added to the 

database from this screen; new directors 
are added from the Add/Edit Directors 
screen under the facility management 
tab. 

 
The screen refreshes and a new field will 
appear, Department Areas (in the example, circled). 
 
Select a department area from the drop-down list or click on Add New Department Area to add a department area. Click on Go. 
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The screen refreshes. The department area appears 
in the box (in the example, “Nurses Station”) and a 
new field opens, Supervisor (in the example, circled). 
 
Select a supervisor for the department area from the 
drop-down list.  
 
Note: A new supervisor cannot be added to the 

database from this screen; new supervisors 
are added from the Add/Edit Supervisors 
screen under the facility management tab. 

 
Status will default to Active unless Inactive is 
selected. Select Inactive to retain information in the 
database for later use. 
 
Click on Update to save the department area 
information.  
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Add/Edit Directors 
 
Select Add/Edit Directors from the 
facility management tab drop-down 
menu. 
 
When the Add/Edit Director screen 
appears, select a hospital system from 
the Select Hospital System drop-down 
menu or enter the name of the hospital 
system into the field. 
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The screen refreshes.   
 
Select a facility from the Select Facility 
drop-down menu.  
 
To add a director to the database:   
 
When the screen refreshes, click on Add a 
Director in the Select Director field.  
 
Enter the name in the Director Name field.  
 
Enter the email address in the Email field. 
 
Click on Save to save. 
 
To edit a director whose name already appears in the drop-down menu: 
 
Select the name from the menu. When the screen refreshes, edit the information as necessary. Click on Save. 
 
Repeat as necessary to add/edit other directors. 
 
 



 

 

 

   26 

Add/Edit Supervisors 
 
The procedure for adding/editing supervisors 
is the same as that for adding/editing 
directors.  
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AUDIT MANAGEMENT TASKS 

Audit Type 
Select Audit Type from the audit 
management tab. The Manage Audit Type 
screen opens.   
 
You can choose an audit type from the 
Select Audit Type field or Global Audit 
Types field drop-down menus, or you can 
add a new or custom audit type. 
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CHOOSING AN EXISTING AUDIT TYPE FROM THE 
GLOBAL AUDIT TYPES FIELD 
Global Audit Types are audits that are available in the 
system for use. 
 
The options that appear in the Global Audit Types 
drop-down menu will depend upon the user’s 
permission level.  
 
The example shows several global audit types 
available. 
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As an example, select “Environment of Care”. The 
screen refreshes and the selected type of audit 
appears in the Global Audit Types field. 
 
Check boxes display that allow you to Include 
supervisor on emails and/or Include director 
on emails. Select/deselect the boxes as 
appropriate. 
 
Click on Save to save. 
 
A message will appear at the top of the screen to 
confirm that the audit type has been saved. 
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ADDING/EDITING AN AUDIT TYPE FROM THE SELECT 
AUDIT TYPE FIELD 
To add a new audit type from the Manage Audit Type screen, 
select Add New Audit Type from the Select Audit Type 
drop-down menu. 
 
To edit an existing audit type, select the audit type from the 
Select Audit Type drop-down menu. 
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In the example, “Environment of Care” is the 
selected audit type.  
 
The page refreshes and new fields display. You 
may need to scroll down to view the fields.  
 
Select or deselect the check boxes to Include 
supervisor on emails and/or Include director 
on emails. 
 
Click on Save to save.  
 
In the Standards field, specify the standards to 
be linked to the particular audit type (In the 
example, the standards are for an “Environment 
of Care” audit type.). 
 
Click on the standards to apply (in the example, 
“Fire Safety”). 
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The page refreshes and a new field opens, 
Deficiencies (in the example, circled in red). In 
this field, specify the deficiencies to be associated 
with the standards for the particular audit type (in 
the example, “Deficiencies for Fire Safety”). 
 
Select from the drop-down menu or click on Add 
New Deficiency to add a new deficiency to the 
standard.  
 
Click on Update to save. 
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The screen refreshes. Three new fields open, Short 
Description, Deficiency, and Points. If you have 
selected an existing deficiency for the standard, 
these fields will be populated. If you have added a 
deficiency, you will enter text into these fields. 
 
The text in the Short Description field is what will 
display on the PDA during an audit. 
 
The text in the Deficiency field is what will display in 
the body of the email sent following completion of an 
audit (This text is also available to an auditor to 
review and edit during an audit.). 
 
Assign a points value for the deficiency in the 
Points field. A value of “1” is a typical point value. 
 
If desired, click Check Spelling. A message will pop 
up, advising you of any words not found in the 
dictionary.  
 
When you are finished with your entry, click on 
Update. A message will appear at the top of the 
page advising you that the new deficiency has been 
added. Click on Close to exit the screen. 
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Manage Audits 
An Auditor uses the Manage Audits function to 
review, edit, and email audit findings after an audit 
has been performed, or to create a text document.  
LOOKING UP AN AUDIT 
First, synchronize the PDA with the computer to 
transfer audit information to the database. See 
instructions for Synchronizing the PDA in this User’s 
Manual.  
 
Then, select Manage Audits from the audit 
management tab drop-down menu. The Manage 
Audits screen opens. 
 
Enter a date range in the Select Date Range fields. 
Type in the start and end dates, using mm/dd/yyyy format, or open the calendar next to each date field to select the dates.  
 
Note: The date range must be at least one day apart. For an audit performed today, the start date is today’s date and the end date 

is tomorrow’s date (In the example “4/6/2006” is the start date and “4/7/2006” is the end date).  
 
 To enter a date range using the calendars: 
 
Click on the calendar icon to the right of the first Select Date Range field. 
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When the calendar opens, select the opening 
date for your audit search.  
 
Use the cursor (or the “<” and “ >” symbols on 
your keyboard) to scroll through the month and 
year fields. Click on the day on the calendar.  
 
The Selected Date will appear at the bottom of 
the screen.  
 
If you are satisfied with the date, click on OK.  
 
When the calendar closes, the start date will 
appear in the left-hand Date field of the Manage 
Audits screen (In the example, the start date is 
4/6/2006.). 
 



 

 

 

   36 

Repeat the process to select an end date 
for your date range, using the calendar to 
the right of the second Select Date Range 
field. 
 
When the calendar closes, the selected end 
date will appear in the right-hand field of the 
Manage Audits screen.  
 
Click on Go. 
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 The screen refreshes and displays a table of 
audits (shown highlighted in yellow) performed in 
the facility within the selected date range.   

A group of light green and gray command 
buttons appears at the bottom of the screen.  
The commands available to most users are 
shown circled. 
To select an audit, click in the check box in the 
left-most column of the table.  
 
Then select a command button corresponding to 
the action you wish to perform, as follows. 
 
Click on Edit Audit to edit the audit within the 
database.  Edits made within the database will 
appear on the email and will be reflected in the 
document when exported to Word. All permanent 
edits must be made in the database. 
 
Click on Export Audit to open the audit file in Word; edits will not be saved in the database, but you can make formatting changes to 
the file that will alter the appearance of the printed document. The Word document is the format of the email that is sent. 
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EDITING AN AUDIT 
To edit an audit, click on Edit Audit; the 
Manage Audits screen refreshes. The facility 
(“Bronson Methodist Hospital”), audit type 
(“Environment of Care”), and auditor (“John 
Doe”), display as a title in green text.   
 
The Date (“11/10/2005”) and Dept. Contact 
(“lisahardesty@comcast.net”) appear below the 
title. The Save Date button (right of screen) lets 
you change the date, if the date when the audit 
was performed is different from the date when 
the findings are edited. 
 
A green sidebar along the left margin shows 
the Areas/Departments audited (“2 
West”/“General Medical Unit”, “3 West”/”Labor 
and Delivery”, etc.).  
 
The table in the middle of the screen lists audit findings (Area, Room, Short Description, etc). If there is a photo attachment, it is 
indicated in the Pic column; clicking on View opens the image to let you verify the correct photo has been attached.  
 
To edit an audit entry, click on Edit in the table cell in the left-most column (In the example, circled in red, the edit will be made to the 
entry for the “Corridor”.). 
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The screen refreshes. The table row for 
the selected area (“Corridor”) now 
displays in green text as editable fields.  
 
A text field displays below the table with 
the Description of the deficiency, 
including any notes or comments added 
during the audit. You can edit this 
material, and any edits made from this 
screen will be saved in the database 
and will also appear in the hard copy of 
the report. 
 
To make edits, first select from the row 
of buttons that displays under the 
Description field to Add, Save, Delete  
Comment or Check Spelling.  
 
Depending on the audit, clicking on any 
field from this screen opens additional 
screens, offering further editing options. 
For example, you can change the value 
of assigned points or edit the Email 
Type field to include additional recipients by clicking on a field (In the example, “Corridor”, circled in red). Scroll down, as necessary, to 
see all the fields and editing options. 
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The screen refreshes and three new boxes open 
across the bottom of the page that locate where 
the deficiency was observed by Facility Areas, 
Departments, and Department Areas.  
 
(In the example, the deficiency was noted in “2 
West” of the “General Medical Unit” in the 
“Corridor”.). 
 
You can change/edit any of these locations, as 
necessary, by selecting alternative areas from 
the drop-down lists. 
 
Note: Remember to scroll down, as necessary, 

to see all the fields and editing options. 
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Another option from 
the Manage Audits 
screen is to click on 
the Add Comment 
button (left image, 
circled in red). 
 
The screen 
refreshes. A new 
table row appears 
(image on right) in 
which to enter a new 
deficiency.  
 
Select an element (in 
the example, “Fire Safety”) from the Elements List. 
 
Select a department area (in the example, “Clean 
Supply”) from the Department Areas list. 
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The screen refreshes. A Deficiency List 
appears. Select a deficiency from the drop-down 
list (in the example, “Doors Latch”). 
 
Assign a points value in the Points column of 
the table (in the example, “1”). 
 
Click on the gray Save Comment button. 
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The screen refreshes. 
 
The deficiency now displays in the table of 
audit findings. Note that the listings are now 
in alphabetical order.  
 
In the example (highlighted in yellow), 
Auditor John Doe noted a “Doors Latch” 
deficiency in the Clean Supply Area of 2 
West in the General Medical Unit of Bronson 
Methodist Hospital during an Environment of 
Care Audit conducted on 11/10/2005. 
 
Note: Remember, because these edits have 

been made using the “Edit Audit” 
command, they will be saved in the 
database. 
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EXPORTING AN AUDIT 
 
The Export Audit command generates a Word 
document for printing.  
 
You will no longer be working in the database, 
so any edits you make will be saved to the 
Word file only and will not be saved in the 
database.  
 
You will be prompted to Save As; choose the 
folder in which you want to save the file, and 
type in a file name, just as you would any Word 
document. 
 
The audit document, with cover sheet (shown), 
is automatically populated with information 
from the database. 
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EMAILING AN AUDIT 
 
When you are ready to email audit findings, 
click on Email Audit in the green field on the 
left of the Manage Audits screen. The screen 
refreshes and a text field displays in which to 
type a brief memo to recipients.  
 
There is no need to address emails to 
recipients. Emails are automatically sent to 
unit managers and all individuals who have 
been previously identified to be included on 
the email. Each person will receive only the 
portion of the audit relevant to his or her area 
of responsibility. 
 
Click on Send to send the email. The audit, 
and any photos, will be sent as attachments 
to your memo.  
 
Note: Remember that you must manually 

delete photos from the PDA after 
uploading the audit to the database. See the section on Deleting a Photo in this User’s Manual for instructions. 
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USER MANAGEMENT TASKS 

Create User 
Requires Permission Level II 
You can only create a user with a lower permission 
level than your own. 
 
Select Create User from the user management tab 
drop-down menu. 
 
When the Create User screen opens, enter the 
appropriate information in the Username and 
Password fields. Passwords must have less than 
20 characters and are case sensitive. 
 
Retype the password in the Confirm Password 
field. 
 
Enter the user’s First Name and Last Name in the 
appropriate fields. 
 
Select a user type from the Select User Type drop-
down menu.  The user type is linked to permission 
level.  
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To review the permission levels, refer to the 
Permission Levels section of this User’s Manual. 
User types include: Audit Type Admin, Facility 
Admin, Hospital System Admin, and User. 
 
Click on Save. 
 
The screen refreshes. New fields display that link 
the user to one or more Audit Type and Facility 
and determine the user’s permission level (In the 
example, “Doug Daniels”, a “User”, will have 
permission at “Bronson Methodist Hospital” to 
perform “Life Safety Code” audits.).  
 
Click on Save to save. The screen refreshes. A 
message at the top left of the screen will indicate 
that the user was created.  
 
If the task was unsuccessful, an error message will 
appear indicating the problem (e.g., password 
problem). 
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Edit User 
Requires Permission Level I 
 
Select Edit User from the user management 
tab drop-down menu. 
 
When the Edit User screen appears: 
 
Select the hospital system from the Select 
Hospital System drop-down menu. 
 
Select a user from the Select User drop-down 
menu.  
 
Note: If a user’s name does not appear  

in the Select User field drop-down list,  
you will have to first select the audit type and  
the facility to which the user is linked. 
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The screen will refresh and new fields will open, allowing 
you to edit the User Type, Audit Type, and Facility 
fields. 
 
Click on Save to save. 
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REPORT TASKS 

Options under the reports tab include Ad Hoc reports and the following 10 ten Static reports: Audit History, Audit Detail/Summary, 
Summary, Director, Supervisor, Department, Standard, Deficiency, Auditor, and Tally Points. 
 
Reports are cumulative documentation designed for trending and for committee meetings and regulatory records requirements. 
 
Ad hoc reports are specialized reports generated by entering specific variables. 
 
Static reports are commonly used reports with few variables.  The ad hoc reports function is the more powerful tool because it allows 
you to pull data for an entire facility into a single report.  
 
Note: Remember, the term “reports” does not apply to the Word document of audit findings emailed to administrators.  
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Preparing a Static Report 

AUDIT DETAIL/SUMMARY REPORT 
 
The most basic static report is the Audit 
Detail/Summary Report. 
 
To generate this type of report, click on 
Audit Detail/Summary in the reports tab 
drop-down menu.  
 
The Report Audit Detail/Summary 
screen opens.  
 
Select a hospital system from the Select 
Hospital System drop-down menu, if the 
system does not appear on the screen. 
 
Select a date range from the Select Date 
Range fields. 
 
Click on Go. 
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The screen refreshes; a table of audits displays. 
 
Select an audit by clicking in the check box in the left table 
column.  
 
Click on View Summary to see an audit summary. 
 
Click View Details to see a more detailed report. 
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The screen refreshes and a Word file opens. 
 
If you selected View Summary, the report 
displays the Areas, Points, and the number of 
Incidents (Deficiencies). If you selected View 
Details, the report also displays the Departments. 
 
In the example, five incidents were recorded 
during an Environment of Care Audit conducted on 
7/5/2004 at Bronson Methodist Hospital. 
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SUMMARY, DIRECTOR, SUPERVISOR, AND AUDITOR REPORTS 
 
The Summary, Director, Supervisor, and Auditor Reports follow the same format and provide similar data: number of deficiencies, 
area, facility, date range, and audit type. 
 
These four reports are “drill-down” reports. Each time a screen refreshes, a new screen opens and you can click on another element 
to gather another piece of information. For example: 
 

• The Summary Report can show, not only the areas in the facility where the deficiencies are occurring, but also the kinds of 
deficiencies in each area. 

• The Director and Supervisor Reports can alert these individuals to the kinds of deficiencies to be on the watch for in their 
area of responsibility, and help them trend areas of improvement. 

• The Auditor Report can show a hospital administrator the types of deficiencies that each auditor is documenting; from this 
information, the administrator can determine the consistency among auditors and decide whether training may be required 
to improve it. 
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The example shows how to generate a 
Summary Report. The steps for generating 
a Director, Supervisor, or Auditor Report 
are the same. 
 
Select Summary from the reports tab drop-
down menu.       
 
When the Report Summary screen 
displays: 
 
Select the hospital system from the Select 
Hospital System field. 
 
Select the facility from the Select Facility 
field. 
 
Select the audit type from the Select Audit Type field. 
 
Enter a date range in the Date Range fields. 
 
Click on Go. 
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The screen refreshes and a report displays as a bar graph.  
 
The report title gives the facility, audit type, and date range. 
 
The y axis shows the number of deficiencies. 
 
The x axis shows the facility area; each bar is color-coded to an area in 
the column to the left of the graph. 
 
In the example (items circled in red), 41 Environment of Care 
deficiencies were found on 1East of Bronson Methodist Hospital 
between 3/1/2000-3/1/2006. 
 
Drill down further by clicking on a facility area in the left column (in the 
example, “I East”).  
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The screen refreshes.  A new bar graph displays, showing the number 
of deficiencies noted within each department of the selected area. 
 
In the example, 33 Environment of Care deficiencies were found in the 
Emergency Department of 1 East, Bronson Methodist Hospital, 
between 3/1/2000 and 3/1/2006. 
 
Click on a department in the left-hand column to obtain more 
information about the deficiencies (in the example, “Emergency 
Department”). 
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The page refreshes. The new screen displays the areas in the 
department and the number of deficiencies in each area, in a 
pie chart format that makes it easy to see the relative 
frequency of each deficiency. 
 
In the example, 10 Environment of Care deficiencies were 
found in the Clean Supply Area of the Emergency Department 
on 1 East, Bronson Methodist Hospital, between 3/1/2000 and 
3/1/2006. 
 
Click on an area in the left table column (in the example, 
“Clean Supply”) to gather yet more information.  
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The screen refreshes and a Word document 
opens that lists each individual deficiency in the 
area and the date and time when each incident 
was noted.  
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STANDARD REPORT 
The Standard Report analyzes the frequency 
of deficiencies related to a particular standard 
associated with an audit type. 
 
The Standard Report is a drill-down report that 
provides more information with each successive 
screen.  
 
To generate a Standard Report, select 
Standard from the reports tab drop-down 
menu.  
 
When the Report Standard screen displays:   
 
Select the hospital system from the Select 
Hospital System field. 
 
Select the facility from the Select Facility field. 
 
Select the audit type from the Select Audit Type field. 
 
Select the standard from the Select Standard field. 
 
Enter the date range in the Date Range fields. Click on Go.  
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The screen refreshes; a bar graph displays, showing the number 
of deficiencies associated with the standard per area within the 
selected date range. 
 
In the example, 25 Fire Safety deficiencies were noted on 1 East 
during Environment of Care audits conducted at Bronson 
Methodist Hospital between 3/1/2000 and 3/1/2006. 
 
Click on an area in the left-hand column to identify where the 
deficiencies were noted (in the example, “1 East”). 
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The screen refreshes; a new bar graph displays, showing the 
number of deficiencies in the selected department during the 
specified date range. 
 
In the example, 18 Fire Safety deficiencies were noted in the 
Emergency Room on 1 East, Bronson Methodist Hospital, during 
Environment of Care audits conducted between 3/1/2000-
3/1/2006. 
 
Click on a facility area in the left column to identify the 
deficiencies (in the example, “Emergency Department”). 
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The screen refreshes. A pie chart displays all the deficiencies 
documented under the standard.  
 
In the example, the pie chart shows the elements that comprise fire 
safety, and the instances of each deficiency noted during audits 
conducted within the selected date range. (Two instances of “Doors 
Latch” issues were noted in the Emergency Department on 1 East, 
Bronson Methodist Hospital, during Environment of Care audits 
conducted between 3/1/2000-3/1/2006.) 
 
Click on the deficiency in the left-hand table to identify when each 
deficiency was noted. 
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The screen refreshes. A Word file displays, showing 
the date and time when each instance of the 
deficiency was noted. 
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DEFICIENCY REPORT  
The Deficiency Report shows the most 
frequently reported deficiencies in the 
facility (for example, the “top five”) within 
a selected date range, and ranks them 
in descending order of frequency. 
 
To generate a Deficiency Report: 
 
Select Deficiency from the reports tab 
drop-down menu.  
 
When the Report Deficiency screen 
opens: 
 
Select a hospital system from the 
Select Hospital System field. 
 
Select an audit type from the Select 
Audit Type field. 
 
Enter a date range in the Date Range fields. 
 
Enter the number of deficiencies to rank in the Number of Deficiencies field.   
 
Click on Go. 
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 The screen refreshes; a report displays, in a bar 
graph that ranks the deficiencies in descending 
order from most frequent to least.  
 
In the example, the five most frequently found 
deficiencies were Ceiling Clearance (54), Doors 
Propped (43), Ceiling Tile (30), Hallway 
Storage/EVS (27), and Doors Latch (19). 
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DEPARTMENT REPORT 
The Department Report shows the departments with 
the most deficiencies within a specified date range. This 
report is useful in discovering the five (or two or ten) 
departments in the facility with the most deficiencies 
within a select audit type.   
 
The Department Report is a drill-down report that lets 
you extract more information, such as the kinds of 
deficiencies and the number of times each one occurred. 
 
To generate a Department Report, select Department 
from the reports drop-down menu.  
 
When the Report Department screen opens: 
 
Select the hospital system from the Hospital System 
field. 
 
Select the hospital from the Hospital field. 
 
Select the audit type from the Audit Type field. 
 
Enter a date range in the Date Range fields. 
 
Enter a number in the Number of Departments field.  Click on Go. 
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 The screen refreshes and a report displays as a bar graph. 
 
The title shows the facility name and date range. 
 
The y axis shows the number of deficiencies. 
 
The x axis shows the departments. The bars are color-coded to 
the list of departments located to the left of the bar graph. 
 
In the example, the five departments of Bronson Methodist 
Hospital with the highest number of deficiencies between 3/1/2000 
and 3/1/2006 were (in descending order)  the Emergency 
Department (33), Oncology (23), Ortho-Neuro Unit (22), General 
Medical Unit (20), and Pediatrics (17). 
 
Click on a department in the left-hand column to identify the 
deficiencies in a department (in the example, the “General Medical 
Unit”). 
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The page refreshes; a new bar graph displays each type of 
deficiency and the number of times it occurred. 
 
In the example, two “Doors Latch” incidents were observed in 
the General Medical Unit of Bronson Methodist Hospital 
between 3/1/2000 and 3/1/2006. 
 
Click on a deficiency in the left-hand column to obtain more 
information (in the example, “Doors Latch”).
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The screen refreshes. A Word file displays, showing the 
date and time when each instance of the deficiency was 
noted. 
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TALLY POINTS REPORT 
 
To generate a Tally Points Report, also 
referred to as a “Performance Report,” 
select Tally Points from the reports tab 
drop-down menu.  
 
When the Report Tally Points screen 
displays: 
 
Select a hospital system from the Select 
Hospital System field. 
 
Enter a date range in the Select Date 
Range fields. 
 
Click on Go. 
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The screen refreshes; the Report Tally Points 
screen displays a table of audits conducted 
within the selected date range. 
 
Click in the check box next to the audit date you 
want to review (in the example, “1/8/2006”). 
 
Click on View Report. 
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The screen refreshes; the Tally Point Report opens 
as a Word document. 
 
Each instance of a deficiency is listed, along with 
actual points and possible points for every 
department and department area. 
 
A total number of points is shown for each 
department area and the percentage of compliance 
is indicated. 
 
A grand total of points is shown at the end of the 
report. The percentage of compliance is indicated (In 
the example, the shading has been added.). 
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Preparing an Ad Hoc Report 
Ad hoc reports have greater power and 
flexibility than static reports. Ad hoc reports 
allow you to select a number of variables in 
order to refine a search or to generate a 
single report that covers an entire facility. 
 
MANEUVERING THE FIELDS 
 
To generate a basic ad hoc report: 
 
Select Ad Hoc Reports from the reports 
tab drop-down menu.  
 
When the Ad Hoc Reports screen 
displays: 
 
Select the hospital system from the Select 
Hospital System field. 
 
Select a report by clicking on Add New 
Report in the Select Report field or enter a report name in the Report Name field (In the example, “Deficiencies per Auditor” will 
report the kinds of deficiencies each auditor in the hospital is tracking.). 
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Go to the Select Fields section of the screen. 
Determine the variables you want to select, based on 
the information you are looking for.  
 
Leave the function box above the green arrows (>>, 
<<) at the default setting, None. (Other setting options 
are Count and Sum. In the example, the information 
desired is neither a total nor a break-down of 
numbers, but simply the identity of the auditors and 
the types of deficiencies that each auditor has 
recorded.) 
 
In the Available Fields box, select “Auditor”.  
 
Click on the right-pointing green arrows (>>) to move “Auditor” to the Selected Fields box. 
 
In the Available Fields box, select “Deficiency Short Description”.  
 
Click on the right-pointing green arrows (>>) to move “Deficiency Short 
Description” to the Selected Fields box. 
 
Skip the remaining fields on the page, and scroll down to the bottom of 
the screen. Click on Run. 
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The report that displays names two auditors, John Doe and Lisa Hardesty, and 
names the deficiencies that each of them recorded. 
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To run a report that counts the deficiencies that the auditors 
found, first clear the fields on the Ad Hoc Reports screen. 
 
In the Select Fields section of the screen, make sure that the 
default, None, is selected in the small function box between 
Available Fields and Selected Fields (The goal is to identify, 
not count, the auditors.). 
 
Select “Auditor” from the list of Available Fields on the left.  
 
Click on the right-pointing green arrows (>>) to move “Auditor” to 
the Selected Fields box. 
 
Now select “Count” in the function box between the two fields. 
 
Select “Deficiency Short Description” from the list of Available 
Fields on the left.  
 
Click on the right-pointing green arrows (>>) to move “Count of 
Deficiency Short Description” to the Selected Fields box. 
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Scroll to the bottom of the screen and click on Run. 
 
 
 
 
 
 
 
 
 
 
 
The new report that displays shows the Total Number of Deficiencies observed (41) and 
the Number of Deficiencies each Auditor recorded. John Doe recorded 21 deficiencies; 
Lisa Hardesty recorded 20.  
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GROUPING 
Grouping divides data into meaningful chunks. 
As an example, let’s say you want to look at the 
findings of the auditors within a particular audit 
type. 
 
In the Select Fields section, select “Auditor” 
and “Count of Deficiency Short Description”, as 
above. (Make sure that “None” is selected in 
the function box before you choose “Auditor” 
from the Available Fields; then make sure that 
“Count” is selected in the function box before 
you choose “Deficiency Short Description” from 
the Available Fields box.) 
 
Go to the Grouping/Subtotaling section of the 
screen. Select “Audit Type” from the Available 
Fields and click on the right-pointing green 
arrows to move it to the Selected Fields box. 
 
Scroll to the bottom of the page and click on Run. 
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The report generated shows the auditors and gives both a total number of 
deficiencies and a break-down per auditor by audit type.  
 
In the example, John Doe recorded 21 deficiencies and Lisa Hardesty 20, for a total 
of 41 deficiencies recorded during Environment of Care audits. 
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EXPORTING AN AD HOC REPORT TO EXCEL 
 
Sometimes, especially when working with many variables, you may want to export a report to work in a spreadsheet application like 
Microsoft Excel.  
 
In Excel, you can reformat data, as desired. Moreover, you can work with Excel functions to analyze data. For example, you can 
create pivot tables and pie charts. 
 
To export a file to Excel, from the Explorer tool bar, choose Select All in the report web page.  
 
Select Copy. 
 
Open Excel and place the cursor in the upper left cell (cell A1). 
 
From the Excel tool bar, select Paste from the Edit drop-down menu. 
 
The data can now be manipulated, using Excel’s many powerful functions. 
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USING THE PDA TO CONDUCT AN AUDIT 

Actual PDA models may vary.  Consult the user manual for your PDA, as necessary. 
 
The PDA unit comes with a cradle/docking station and a stylus. The camera may be built into the 
PDA. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PDA 

Stylus 

Cradle/Docking Station 
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SYNCHRONIZING THE PDA 

Synchronizing the PDA with the computer means enabling the two  
devices to communicate and keep information up-to-date. You  
can share files, display updated contacts, appointments, and tasks,  
and send and receive email messages. 
 
It is recommended that, before performing an audit, you always  
synchronize the PDA with the facility management database.   
Synchronize the PDA again before editing or emailing an audit. 
 
To synchronize the PDA: 
 
Insert the PDA into the docking station. 
 
Insert the USB cable into the USB port on the computer.  
 
Turn on the PDA.  
 
Make sure you have an Internet connection. 
 
Microsoft ActiveSync opens automatically and displays a “Looking for changes” 
message. It’s important to let this process run to completion before going further. 
 
When ActiveSync displays a message that synchronization is complete, initialize 
RepliSync on the PDA. Leave the PDA in the docking station. 
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On the PDA, go to Programs; tap the RepliSync icon.  
 
When RepliSync opens, tap Start to begin synchronization.  
 
During synchronization, all the information gathered by the PDA is transferred to the database. 
Once the transfer is complete, the data is erased from the PDA and is no longer available from 
that device. The information is now available only  through the Facility Management Software 
on the computer. 
 
When synchronization is completed, RepliSync will display a “Synchronized” message. If the 
message does not appear, contact your systems administrator. 
 
RepliSync will close automatically. 
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PERFORMING AN AUDIT 

Starting a New Audit  
 
From the Programs menu, open the Pocket Audit application.  
 
Select File from the bottom left of the screen (circled in red). From the file pop-up menu, 
select New Audit. 
 
To open and close the keyboard, tap the keyboard icon located at the bottom right of the 
screen (circled in red). Use the keypad and stylus to enter information and comments. 
Throughout most of this section, the keyboard will be hidden, as in the “off” position. 
 
Note: Some PDA models have smaller screens. Use the appropriate scroll bars to scroll 

up, down, right, or left to view all fields on a screen.  
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When the Select Hospital screen displays, select a facility from the Select Facility drop-
down menu. 
 
Choose an audit type from the Select Audit Type drop-down menu. 
 
Tap in the Auditor box and enter your name.  
 
Tap OK. 
 
 
Note: To resume an audit already in progress (e.g., after a lunch break) or to toggle 

between audit types, select Open Audit from the File pop-up menu. When the 
Open Audit screen displays, select an audit from the list. Tap Open. 
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When the screen refreshes, the facility selected will 
appear in the Facility field at the top of the Pocket 
Audit screen.  
 
You must enter something in all of the following 
fields in order to document a deficiency: 

• Building 
• Facility Area 
• Department 
• Dept Area 

 
Note: You may need to scroll down to view all the 
fields. 
 
To add a room name (optional), tap the + sign next 
to the Room field. A Room Name screen opens.  
 
Enter a room identifier (e.g., a name or number) into  
the Room Name field. 
 
Tap OK. 
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Tap the Deficiencies tab (circled in red).  
 
The Deficiencies screen opens. From this screen, you can record any deficiency found 
during the audit. 
 
The Deficiencies screen features a drop-down menu of Elements, the standards or goals 
that must be met to achieve compliance. In the example, the Element is “Fire Safety”; the 
Deficiency is “Exit Blocked”.  
 
Three icons appear on this screen to the left of a text box (yellow highlighting added). To 
operate these icons, you must first select a deficiency from the Deficiency drop-down menu, 
then tap the + sign. The deficiency will appear in the text box.  
 
Then tap one of the icons, as follows: 
 x – to remove a deficiency that has been entered. 

p – to attach a photo to the deficiency. 

e – to view the standard in order to verify compliance with what you observe. 
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Recording a Deficiency 
 
From the Deficiencies tab, first select a standard from the Element drop-down menu (in 
the example, “Fire Safety”).  
 
In the next field, select the intended recipients for the email you will send after you complete 
the audit. The default, “Unit Only”, means that only the unit-level administrators will be 
included in the email.  
 
Next, select a deficiency from the Deficiency drop-down field.  
 
Highlight the deficiency, then tap the + sign.  
 
The deficiency appears in the text box. 
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Adding a Custom Deficiency 
If the appropriate deficiency does not appear in the 
Deficiency drop-down field, add a custom deficiency. 
 
From the Deficiencies tab, tap the + sign; the Custom 
Deficiency screen opens.  
 
Use the keyboard to make a brief entry in the Short 
Description field.  
 
You must also enter a more complete description in the 
Description field. When you have finished, close the 
keyboard. The entered text will comprise the body of the 
email.  
 
Assign a point value of 1 or greater in the Point Value 
field. 
 
Tap OK. 
 
Deleting a Deficiency 
To delete a deficiency, from the Deficiencies screen, highlight the deficiency in the Short Description text box. 
 
Tap the x icon. The deficiency will be deleted. 
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Reviewing a Standard 
To review or edit (e.g., add notes to) the standard for the deficiency, from the 
Deficiencies screen, highlight the deficiency in the Short Description text box. Tap the e 
icon.  
 
A screen opens with the Short Description at the top (in the example, “Exit Blocked”) 
and a Description field that displays the standard; these are the conditions that must be 
met for compliance. 
 
Tap at the end of the text in the Description text box to position the cursor (in the 
example, highlighted by arrow). Open the keyboard, if necessary. Type your comments or 
notes. Close the keyboard. 
 
Tap OK to save. 
 
When the screen closes, you will be returned to the Deficiencies screen. 
 



 

 

 

   92 

Adding a Location 
 
While conducting an audit, you may find an area to inspect 
that does not appear in the PDA. 
 
To add a new location to the audit: 
 
Tap the Edit tab at the bottom of the Pocket Audit screen 
and select New Building, Facility, Department, or 
Department Area from the drop-down menu. 
 
A New Area screen opens. Enter a name or number into the 
Name field. 
 
Tap OK to close the screen. 
 
Note: After you add a new area, you must go back and 

select it from the drop-down box to add it to the 
audit. 
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Taking and Attaching a Photo 
 
For detailed instructions on camera setup and adjusting the camera settings, see the 
section on Setting up the Camera in this User’s Manual. 
 
To take a picture during an audit: 
 
From the Deficiencies screen, select the Deficiency. 
 
Tap the + sign. 
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The deficiency will appear in the large text box. 
 
Tap the p icon (in the example, circled). 
 
With the audit still open on the PDA, open the camera application, as follows. 
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Tap the Microsoft icon at the top of the screen and go to Start>Programs. 
 
Tap the camera icon in the menu bar or in the drop-down list.  
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 The PDA screen will display as a camera. 
 
Hold the camera in landscape orientation. 
 
Use the Viewfinder to center the image.  
 
Press the Shutter release button to capture the image. 
 
A Wait icon displays while the camera processes the image. 
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The captured image will automatically appear on the camera screen for 
Instant Review. Refer to the section Setting up the Camera in this User’s 
Manual for more information about Instant Review. 
 
Three icons appear on the screen (shown enlarged): a trash can, an envelope, 
and an “ok” button. 
 

• If you are satisfied with the image, tap OK.  
 

• If you are not satisfied with the image, tap the trash can icon. 
 

• To cancel Instant Review and continue taking photos, tap anywhere on 
the screen. 

 
• To attach the photo to the audit, tap the Envelope icon. 
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The image folder will open, listing the available image files. Most of the time, the photo will 
appear at the bottom of the file list; sometimes it does not. Be sure you select the correct 
image number.  
 
Tap the file to select it.  
 
Tap the Close button (X) to close the camera. 
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You will be returned to the Deficiencies screen. The deficiency in the text box will now 
have an asterisk to the left to indicate that a photo is attached. 
 
Note: Only one image can be attached to a deficiency.   
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Performing Post-Audit Tasks 
 
Following completion of an audit, synchronize the PDA with the computer again. All the audit information gathered will be entered into 
the database and erased from the PDA.  
 
Review, edit, and email audit findings from the computer by accessing Manage Audits from the audit management tab on the 
Facility Management Software. See the section Manage Audits in this User’s Manual for complete instructions.  The data and photos 
gathered during the audit automatically populate the audit findings that are issued by email. 
 
Note: Photos must be manually deleted from the PDA. Perform this task, per the instructions in the next section, after reviewing the 

audit findings in the database. This will ensure that all photos are still available for use, should you discover that the wrong 
photo has been attached to a deficiency.  
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Deleting a Photo 
 
Go to Programs and select the Camera icon. 
 
When the camera application opens, tap the Instant Review button. 
 
All the photos will display. 
 
Tap the Close button (X) in the upper right to close Instant Review.  
 
The most recent photos will appear, numbered, across the lower 
region of the screen. 
 
Select the photo to delete (in the example, highlighted by the arrow).  
 
The image, along with the file name, will appear on the screen. 
 
Select Delete from the Edit menu (or, depending on your camera,  
tap the Delete button).  
 
When the message displays verifying the deletion, tap Yes.  
 
The image will be deleted from both the PDA and the audit. 
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SETTING UP THE CAMERA 

Actual camera models and features may vary.  Consult the User’s Manual for your camera, as 
necessary. 
 
This section explains camera features and setup. The steps for taking photos during an audit 
appear in the Using the PDA to Conduct an Audit section of this User’s Manual.  
 
LAUNCHING THE CAMERA APPLICATION 

Tap Start>Programs on the PDA. 
 
Tap on the camera icon in the menu bar. 
 
Alternatively, launch the application by pressing a hardware application button that has been mapped to the camera application. 
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The PDA screen displays as a camera  
 
In the upper right are the Shots left indicator (in the example, shown as 
“7234”), which is the number of shots that can be taken based on resolution, 
compression, storage space, and the complexity of the image, the File 
compression setting (represented by stars), and the Resolution setting 
(“160x120”).  
 
A Viewfinder appears in the center of the screen  
 
A Camera controls panel displays across the bottom.  
 

EXITING THE CAMERA APPLICATION 

In portrait mode, tap File>Exit. 
In landscape mode, tap the Close (X) button on the Camera controls panel. 
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ADJUSTING THE CAMERA SETTINGS 

 
Tap the Menu icon on the control panel. From here you 
can select the Settings or Setup tabs to adjust the 
camera. 
 
Settings Tab 
Several camera settings can be adjusted under the 
Settings tab; only the resolution setting is important for 
the purposes of emailing an image as part of an audit.  
 
To change any setting, select the setting from the  
Settings tab.  
 
Tap the Change button or double-tap on the setting in the  
list.  When the Settings screen opens, highlight your new  
setting preference.  Tap OK at the top right of the screen   
to close the screen. 
 
Tapping the Reset button will reset all settings to the  
default. 
RESOLUTION  

The resolution setting selects the width by height in pixels of the captured image. The default resolution setting is 160 x 120; for best  
results, set the resolution to 320 x 240. 
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EXPOSURE MODE 

The exposure mode setting adjusts the F-number and shutter speed. 

• Auto mode selects the best F-number and shutter speed. 

• Action mode lets you select fast shutter speeds to stop action. 

 

Setup Tab 
The Setup tab contains settings that are available to all camera devices, regardless of 
PDA model. 
 
To change a setting, select the setting and tap Change, or double-tap on the setting in the 
menu.  
 
To reset to the default values, tap Reset.  
 
The settings important to the Facility Management Software are Instant Review and Self-
Timer. 
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INSTANT REVIEW 

Immediately after you take a photo, the captured image 
displays on the screen for review. The image displays for 
only as long as the Instant Review has been set. 
 
Setting options include: 

Off – disable Instant Review 

2 seconds – 2-second review (default) 

4 seconds – 4 second review 

6 seconds – 6-second review 
 
SELF-TIMER 

Setting options include: 
Off – Picture is taken immediately after shutter button is pressed (default) 

On: 2 seconds – Picture is taken 2 seconds after shutter button is pressed 

On: 10 seconds – Picture is taken 10 seconds after shutter button is pressed 
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File Tab 
Image files are listed under the File tab. 
 
The Filename prefix is the text added to the prefix of the file name. The default text is 
“snap”. 
 
The Current counter value is the number appended to the filename prefix. This number 
will automatically increment every time a picture is taken. Once it exceeds 9999, the 
number will return to 0000. If the filename already exists, the next number will be used. 
 
An example of a default filename is “snap0046” (in the example, yellow highlighting 
added). 
 
The Save pictures in field shows the name of the folder where the images are saved. The 
location will be set up at the time of facility setup. 
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OTHER CAMERA FEATURES 

Zoom 
• To zoom in: Press the Zoom In button or press up on the control pad. 
• To zoom out: Press the Zoom Out button or press down on the control pad. 

 
During zoom, the zoom indicator will appear to show the current zoom state. If zoom is set to the default level (wide angle), the 
indicator will disappear after a few seconds. Otherwise, it will remain on screen. 
 
Zoom is not available on all cameras. 
 
Exposure Compensation 
Use the EV setting to override the default exposure setting (0.0) of the camera and manually correct for scenes that are too dark or too 
bright. Adjusting the EV setting changes the shutter speed and/or the gain. EV values can be adjusted between -3.0 and 3.0 in 
increments of 0.5. 
 

• Setting a more positive EV makes the images brighter. Press right on the control pad. 
• Setting a more negative EV makes the image darker. Press left on the control pad. 
 

During EV adjustment, the EV indicator will show the EV state. If EV is set to the default level (0.0), the indicator will disappear after a 
few seconds. Otherwise, it will remain on the screen. 
 
Exposure compensation is not available on all cameras. 
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On-Screen Indicators 

• Camera shake warning indicator (  ) – Available on some cameras, the camera shake warning indicator displays when the 
shutter speed is slower than 1/15 seconds to indicate that the camera should be held steadily or braced against a surface 
before taking a picture to avoid blurring. 

 

• Timer indicator (  ) – The timer indicator displays, if the timer is not turned off. 
 
Additional indicators will be shown in the upper left of the screen, if the settings are changed from the default values. 
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PDA MAINTENANCE 

Keep battery charged. 

Synchronize the PDA before and after conducting an audit. 
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TROUBLESHOOTING 

Problem Error Message Possible Causes Corrective Action 

Camera icon does 
not appear in the 
PDA toolbar 

No message  

• Go to Programs.  

• Click on HP Photo Smart to activate 
camera.  

• Take a photo.  

• The camera will be added to the 
toolbar. 

Incorrect username or password
Make sure username and password are 
typed correctly; username and password 
are case sensitive.  

Forgotten username or 
password Check with your System Administrator. 

Login problems with 
the Internet 
application. 

Error: The username and 
password combination you 
provided was invalid. 

 

Restricted permission level Check with your System Administrator. 
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Problem Error Message Possible Causes Corrective Action 

Microsoft 
ActiveSync is not 
working. 

No message Several possible causes 

• Remove the PDA from the docking 
station. Wait 30 seconds, then replace 
it into the docking station. 

• Make sure the PDA is turned on. 

• Do a soft rest on the PDA by following 
the instructions in your PDA Manual. 

• Restart the computer. 

• Make sure you have a standard or 
guest partnership. 

• If you are still unable to get a 
connection, contact your System 
Administrator. 
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Problem Error Message Possible Causes Corrective Action 

PDA does not 
display audits. 

 • PDA was not synchronized 
with the database. 

• Synchronization was not 
allowed to run to completion. 

Synchronize the PDA and computer by 
running ActiveSync and RepliSync. Wait 
for message that synchronization is 
finished before disconnecting the PDA. 

Battery is dead. Charge the battery. 

PDA will not start. No message PDA is not correctly inserted 
into the docking station to allow 
the battery to charge. 

Make sure PDA is correctly inserted into 
the docking station. 

PDA will not 
synchronize. 

A request to send data to a 
computer running IIS has 
failed. 

There is no Internet connection. 

• Make sure PDA is connected to the 
PC. 

• Make sure Internet connection is 
established. 

• Make sure that Microsoft ActiveSync 
has run before starting RepliSync. 
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Problem Error Message Possible Causes Corrective Action 

   
If you are trying to run RepliSync from a 
hotel, you may need to request a bridge or 
a new IP address from the hotel front desk. 

The header is corrupt or 
missing. 

There is an Internet connection, 
but PDA is unable to send data. 

If you are trying to run RepliSync from a  
hospital, you must add the proxy URL 
used by the hospital to the PDA: 

• Open RepliSync.  

• Go to File>Remote DB Settings.  

• Make sure the information in the Login 
name and Password boxes is correct. 

PDA will not 
synchronize. 
 

The process could not 
connect to Distributor 
‘kdata1 1’. 

Login name is not entered 
correctly on the PDA. 

• Open RepliSync.  

• Go to File>Remote DB Settings.  
• Make sure login information is correct. 
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Problem Error Message Possible Causes Corrective Action 

 Publication does not exist. 
Publication does not exist. 
The publication is not entered 
correctly on the PDA. 

• Open RepliSync.  
• Click on File>Remote DB Settings.  

• Check the Publication box to make 
sure everything is spelled correctly, 
with no additional characters or spaces. 

PDA will not 
synchronize. 

 

The subscription to 
publication xxx is invalid. 

You did not delete a previously 
used publication before 
selecting this one. 

• Go to Programs.  

• Click on File Explorer icon.  

• Select the bluegranite folder.  

• Delete the hss file by pressing hss with 
the stylus for five seconds.  

• A menu will display; select Delete.  

• When prompted, select Yes.  

• Start RepliSync. Database should 
synchronize successfully. 
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Problem Error Message Possible Causes Corrective Action 

PDA will not 
synchronize Subscription expired. This publication has not been 

used in the past 14 days. 

• Delete the hss file by pressing hss with 
the stylus for five seconds.  

• A menu will display; select Delete.  

• When prompted, select Yes. 

• Start RepliSync. Database should 
synchronize successfully. 
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Problem Error Message Possible Causes Corrective Action 

PDA will not 
synchronize. No file. The bluegranite folder has been 

removed from the Program files. 

• Go to Programs.  

• Click on the File Explorer icon.  

• Make sure My Device displays in the 
top left of the PDA screen.  

• Select the Program Files folder.  

• Look for the bluegranite folder. If this 
folder does not exist, create one, as 
follows: 

o Click on Edit>New Folder.  
o Name the new folder 

“bluegranite”.  
o Run RepliSync. 

Photos are blurry. No message 

Camera resolution setting may 
need adjustment; user may be 
snapping photos too hastily, not 
allowing camera time to adjust. 

In camera mode, check the resolution 
setting; take more time when taking photos 
to allow the camera to automatically 
adjust. 



 

 

 

   118 

Problem Error Message Possible Causes Corrective Action 

Photos are upside 
down. No message Flip mode on the camera has 

been activated. Reset the flip mode on the camera. 

Program (e.g., 
RepliSync) removed 
from PDA. 

No message PDA batteries are dead. Reinstall program. Contact System 
Administrator. 

Unable to delete the 
hss file. 

Unable to delete the hss 
file because of a sharing 
violation. 

More than one application is 
running. 

• Go to Start>Settings>System.   

• Click on the Memory icon.  

• Click on Running Programs>Stop All.  
• Make sure the Running Program List 

is empty. If the list is not empty, click on 
Stop All again. If the list is empty, 
close out by clicking on OK in the top 
right corner of the screen. 

• Delete the hss file by pressing hss with 
the stylus for five seconds.  
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Problem Error Message Possible Causes Corrective Action 

• A menu will display; select Delete.  

• When prompted, select Yes. 

Restricted permission due to 
User level. Check with your System Administrator. 

Unable to view 
photos or reports No message 

Pop-up screens may be 
blocked.  Check with your System Administrator. 

Wrong comment 
attached. No message User error Turn to the Editing an Audit section of this 

User’s Manual. 

Wrong department 
or location attached. No message User error Turn to the Editing an Audit section of this 

User’s Manual. 

Wrong photo 
attached. 

No message User error Turn to the Editing an Audit section of this 
User’s Manual. 
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GLOSSARY 

THE COMPUTER SOFTWARE AND DATABASE 

Term Definition 

Ad Hoc Report A customized report type designed to allow users to select the desired variables 

Add/Edit The function used to add new facility or audit information or to make a permanent change to existing 
information relating to a database entry 

Audit Type The audit management task used to Identify/name an audit created for use on the PDA 

Auditor The person responsible for performing an audit/inspection and who may be the person who finalizes it 

Date Range The range of dates for data the user would like to include for reporting purposes 

Deficiency The description of non-compliant observations made when performing an audit; also the text field that is 
available for review on the handheld PDA during an audit and is communicated to responsible parties 
via email afterward 

Department 
Manager Link The function used to link a manager to a department 

Director Link The function used to link departmental managers to the responsible party 
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Term Definition 

Element All the things that need to be done to achieve a goal or standard 

Email Audit The function used to email an audit to the responsible parties 

Export Audit The function used to export an audit into a Word document 

Global Audit Type An audit named and available in the database for use by all clients 

Manage Audits The function tab on the Facility Management Software web banner used to view, edit, email, or finalize 
audit findings 

Performance Report A report available for users which tallies the assigned audit points; most commonly used with Quality 
Assurance and Housekeeping audits; also called the Tally Points Report 

Permission Levels Access to database functions determined by User Type, as follows: 

• Consultant—Access to data for multiple health systems; able to add or edit a database for 
consultants assigned accounts 

• Hospital System Administrator—Access to data for all hospitals or facilities within a health 
system; able to add or edit the database for the entire health system 

• Facility Administrator—Access to data within one hospital or health system; able to add or edit 
the database of that one hospital 
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Term Definition 

• User—Access to only certain audit types and to all reports; not able to add or edit the database 

Points The value applied to a deficiency for reporting purposes 

Short Description The description of a deficiency that appears on the PDA as the standard 

Standard The goal to be achieved and maintained; may be a regulation  

Static Report Ten drill-down reports available to all users 

Supervisor Link The function used to link a responsible party to department area(s) 

Synchronization Process by which a user keeps information up to date on both PC and PDA; allows the user to share 
files, display updated contacts, appointments, and tasks, and send and receive email messages 

Web-based 
Application 

A software program, such as the Facility Management Software Program,  in which all or part of the 
program is downloaded from the Internet each time the program is used 

Word Document The version of the audit findings exported from the database for formatting and printing 
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THE HANDHELD PDA 

Term Definition 

Add/Edit A function on the PDA that allows the user to add a new building, new facility area, new department, 
and/or a new department area to the database from the PDA when performing an audit; the new audit 
will become permanent to the database and will be available in the drop-down menu during future 
audits. 

Custom Deficiency A function on the PDA that allows the user to enter a deficiency that is not in the Audit Type database; 
the deficiency will appear in the Word document and in reports, but will not be saved for future use. To 
make a deficiency permanent, it must be added to the database from the Audit Type menu under the 
audit management tab menu on the web application 

Drop-down Menu A menu whose contents are shown only when the user activates it, normally by clicking on the box or a 
small arrow next to the box, whereupon the menu items appear below the title 

Icon A graphical user interface on a computer screen that represents a specific program, for example the 
Pocket Audit Program, the RepliSync program, and the Camera application; clicking the icon opens the 
program.  

Microsoft 
ActiveSync A program that allows the PDA to communicate with the computer 

New Audit The menu choice selected under the “File” tab on the PDA when the user wants to create a new 
document, as when beginning an audit 
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Term Definition 

Open Audit The menu choice selected under the “File” tab on the PDA when the user wants to re-open an audit 
interrupted in progress after having closed the Pocket Audit application (as, for example, after a lunch 
break) or to toggle between more than one audit 

Personal Digital 
Assistant (PDA) The handheld computer used to collect audit data 

Pocket Audit The audit application, available from the Programs menu, opened by clicking the Pocket Audit icon 

RepliSync A program used by the Facility Management Software application to transfer data from the PDA to the 
server on which the web-based software application resides; the transfer is done via the user’s 
computer and an Internet connection. 

Scroll Bar A graphical user interface displayed on the PDA screen which, when manipulated with the stylus, allows 
the user to move vertically or horizontally to view all portions of a screen or image; usually features 
directional arrows 
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